
CCH Axcess™ Tax

2015-4.0 Release Notes

June 19, 2016

Contents • 1

Contact and Support Information 2

Information in Tax Release Notes 3

Highlights for Release 2015-4.0 4

Tax Updates 4

Electronic Filing 5

Tax Product Updates 6

Individual (1040) Product Updates 6

Partnership (1065) Product Updates 9

Corporation (1120) Product Updates 11

S Corporation (1120S) Product Updates 14

Fiduciary (1041) Product Updates 15

Estate & Gift (706/709) Product Updates 18

Exempt Organization (990) Product Updates 19



Contact and Support Information
Return to Table of Contents.

Product information can be accessed by visiting Customer Support online: CCH Axcess Product Support.

In addition to product and account information, the Customer Support site offers answers to our most
frequently asked questions, forms release status, Knowledge Base articles, training videos, and operating
systems compatibility for each CCH Axcess™ module. Access to these features is available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes.

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to find Support calendars, as well as options to enter Web tickets for assistance.
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https://support.cch.com/productsupport/productsupport.aspx?id=37
https://support.cch.com/Axcess/ReleaseNotes/Tax
https://support.cch.com/Notes/appStatus.aspx?type=SaaS&amp;prodid=934
https://support.cch.com/Contact


Information in Tax Release Notes
Return to Table of Contents.

CCH Axcess™ Tax Release Notes inform you of the enhancements and updates that were made to Tax
products and systems with the current release.

Information provided in the Release Notes include the following:

Contact and Support information
Updates to Tax technology (such as, electronic filing updates, Organizer, roll forward, and
technology enhancements)
Updates made to Tax products (such as, form additions and updates, changes in diagnostics,
and changes caused by regulatory updates)

To access a list of CCH Axcess™ Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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https://support.cch.com/axcess/releasenotes/tax/
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Highlights for Release 2015-4.0
Return to Table of Contents.

Tax Updates

Individual

Amortization Report. A new amortization report is now available.
Wages Statement. The wages statement now includes a statement reference number on Form
1040, line 7. Previously, no statement reference printed.
Federal Links Worksheet. We are adding an indicator that the return used Autoflow allowing
firms to easily scan for returns that used Autoflow.

New York

Amended letters now reference electronic filing in lieu of mailing the form.

Note: 2014 letters continue to refer to mailing a check despite direct debit information being
present on Form 201-X. This will be resolved with Release 2014-6.1 scheduled for July 24, 2016.

Corporation
New York

The new government forms for the Combined Franchise Tax Return are now available. Significant changes
have been made to Form CT-3A (Combine) and Form CT-3/AB (Member's Detail Report). All associated
forms, schedules, and worksheets are also available.

Fiduciary
Federal Links Worksheet. We are adding an indicator that the return used Autoflow allowing firms to
easily scan for returns that used Autoflow.

Exempt Organization

Georgia

New legislation changes the interest rate from the fixed 1% per month to an annual rate of 6.5% beginning
July 1, 2016. The software will reflect this change effective after June 30, 2016.

Individual, Partnership, Corporation, S Corporation, and Fiduciary
A new field is available on the depreciation summary grid in Individual (1040), Partnership (1065),
Corporation (1120), S Corporation (1120S), and Fiduciary (1041) to delete specific assets from the next
year.

Georgia

New legislation changes the interest rate from the fixed 1% per month to an annual rate of 6.5% beginning
July 1, 2016.
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The software will reflect this change effective after June 30, 2016.

Nevada

The preliminary version of the Nevada Commerce Tax Return is available on this release. This is a new
return for tax year 2015 that is due on August 15, 2016. Input is on the worksheet Nevada > General. The
return is a paper only filed return. Electronic filing is not available for the State of Nevada.

The final version of the form has not been released by Nevada, upon it's release it will be included in our
next available release.

Partnership and S Corporation

Georgia

Form G-7 NRW, Nonresident Withholding Return, and the accompanying worksheet have been added for
processing. Note that government approval is still pending on the substitute form/payment voucher.

Electronic Filing
The following are available for electronic filing:

Corporation
New York Combined

Fiduciary
Oklahoma
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Tax Product Updates

Individual (1040) Product Updates
Return to Table of Contents.

Federal
Form 3520-A. The Initial and Final check boxes are loaded based on the information entered on Foreign >
Form 3520 - Return to Report Transactions with Foreign Trusts > General Information > Return code when an
that indicate an extension was filed is selected.

The IRS issued Revenue Procedure 2016-29. It included thirteen new automatic change codes to be used on
Form 3115. The program was updated to include the new change codes.

Electronic Filing
Electronically filed states no longer print a full government copy when Nevada is the home state.

Georgia
Form GA500, Page 5, Schedule 1, Line 9 for Path2college 529 Plan, is not limited.

Iowa
Form IA 1040, Line 10, for resident returns matches federal Form 1040, Line 17.

Form IA 1040, Line 6, for resident returns matches federal Form 1040, Line 13.

Form IA 126, Line 8, is not filled for nonresident Iowa taxpayers.

IA 2210 no longer prints when the prior year tax exception is not met, but no penalty is calculated.

Iowa gambling winnings appear on Missouri Schedule CR, line 4 as other income.

Iowa Electronic Filing
Form IA 100 instead of Form IA 100S is produced for spouse capital gain deduction input on married filing
joint returns.

Form IA 100 qualifies for electronic filing when installment sale information is present and principal
received in the tax year is zero.

Form IA 133 qualifies for electronic filing when no current year credit is calculated.

Form IA 147 is not produced when there is no tax left to offset.

Kansas Electronic Filing
Estimates will not be in the electronic file twice resulting in the bank account being debited twice when
less than four estimates are present but more than one Direct Deposit/Electronic Funds Withdrawal coded to
the Kansas return.
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Maryland
Any taxes paid for a separate local return should be manually entered on new input located on the Maryland
> Credits > Credit for Taxes Paid section > Local Credit for Taxes Paid grid. The local net income and tax
will be added to Form 502CR, Part A, Lines 2 and 11, on the same sheet for the corresponding state. Taxes
paid for a separate local return are not automatically picked for the credit for taxes paid computation.

Minnesota
Form M1C, the Increasing Research Activities credit, calculates on carryovers only.

When Form M1PR, Lines 22 and Line 23, are both greater than zero and Line 24 is zero, the form continues
to calculate beyond Line 24.

Mississippi
Form 80-108, Part II, Lines 1 through 3, calculate all source amounts and amount not taxable to Mississippi
correctly.

Form 80-205 part-year to and from dates fill with 01012015 and 12312015 if specific dates are not entered.

Supporting statements specific only to Form M1PR print following Form M1PR. Statements for Form M1 and
its supporting schedules print before Form M1PR.

Nebraska
When a social security subtraction is present on Schedule I, Line 27, a copy of the federal return prints with
the Nebraska government copy.

Nevada
The preliminary version of the Nevada Commerce Tax Return is available on this release. Input is on the
Nevada > General worksheet. This is a new return for tax year 2015 that is due on August 15, 2016. The
return is a paper only filed return. Electronic filing is not available by the state of Nevada. The final version
of the form has not been released by Nevada. Upon it's release, it will be included in our next available
release.

New York Electronic Filing
Transmittals and filing instructions indicate electronic filing for amended returns, rather than instructing
the return to be mailed.

North Dakota
The Form ND-1, Fill in if applicable section, Amended: Federal NOL check box fills when selected on the
Amended Return > General worksheet, Changes pertain to net operating loss carryback field.

North Dakota Electronic Filing
The filing instructions reflect the estimates are being electronically filed when electronically filed estimate
payments are present in the return and Form 1099-INT, Form 1099-DIV, 1099-MIC, or Form 1099-R is present
in the return.
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Ohio
Form IT Waiver includes the spouse's middle initial if applicable.

Schedule A, Line 32, excludes Medicare premiums from the Ohio health care cost deduction.

Schedule IT BUS fills from input on the Ohio Income Tax (IT 1040) > Income / Deductions > Ohio Business
Income > Net capital gain (loss) field.

Ohio Electronic Filing
A federal exemption is not used on a dependent of another return when Federal Form 8615 is present.

Business entities listed on Schedule IT BUS always indicate taxpayer and/or spouse ownership using input
defaults when this data is not entered.

Pennsylvania - Philadelphia
Form BIRT-EZ, Line 1 or 2, BIRT, Schedule A, Line 1, or BIRT, Schedule B, Line 1, includes sale of capital
assets.

Select the W-2 name with a pick list for completion of Forms AR or WTR for the Earnings tax or Wage tax
refund petition.

Virginia
Form 763S amount requested for refund is treated as withholding when there is no withholding present for
Virginia.

Wisconsin
The proration of long term care insurance on Form 1NPR uses all income instead of only self-employment
income for purposes of the ratio used in the calculation.
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Partnership (1065) Product Updates
Return to Table of Contents.

Federal
Diagnostic 20347 was updated to reference Form 1065, Page 2, Previously, it made reference to Page 3.

Schedule K-1, Line 11F, includes income from the installment sale of Qualified Small Business Stock.

The IRS released Revenue Procedure 2016-29. The Form 3115 program was updated to include the new
automatic change codes.

Georgia
Form 700, Page 5, Schedule 8, Line 7, Other income, was revised to included Income from Discharge of
Indebtedness.

Illinois
IL-1065, Line 40, total sales everywhere, includes returns and allowances.

Kentucky Electronic filing
Disqualifying diagnostics for the Kentucky Extension does not issue when an electronically filing is not
requested for the extension.

Nebraska
Government form overrides on Schedule II create additional records for partner names and addresses without
removing calculated records.

Nevada
The preliminary version of the Nevada Commerce Tax Return is available on this release. Input is on the
Nevada > General worksheet. This is a new return for tax year 2015 that is due on August 15, 2016. The
return is a paper only filed return. Electronic filing is not available for the state of Nevada. The final
version of the form has not been released by Nevada. Upon it's release, it will be included in our next
available release.

Rhode Island Electronic Filing
Disqualifying diagnostic 45515 will prevent export when RI-1065 Sch G has a blank State/Date of
incorporation field.

Disqualifying diagnostic will prevent negative amounts from exporting on RI-1120C Sch C for Partnership
returns.

Wisconsin Electronic Filing
Diagnostic 40201 was added for Form 1CNP if the partnership type is not identified in the return.

Diagnostic 49472 was added for returns with a different number of copies of Schedule 3K-1 than the number
of partners listed on Form 3, Page 1.
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Diagnostic 49473 was added for returns with both the Trust and Individual information filled in the
Disregarded Entity section of Schedule 3K-1, Page 1.
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Corporation (1120) Product Updates
Return to Table of Contents.

Federal
NOL carryovers subject to section 382 are now properly recognizing the 20 year carryover period for losses
originated prior to year 2000.

The IRS issued Revenue Procedure 2016-29. It included thirteen new automatic change codes to be used on
Form 3115. The program was updated to include the new change codes.

Consolidation
Under the Export tab, new Consolidated Members’ NOL Pro Forma Adjustment worksheets were added to
assist with separate company adjustments due to consolidated differences when Pro Forma is processed in
the following year. These grids will automatically be filled for a consolidated return. They are not
automatically filled for a non-consolidated return.

Some background is in order. Any 2015 consolidated NOL adjustments are not automatically taken into
account when a consolidated member company’s Pro Forma is processed in 2016. In the past, each separate
member’s NOL rolled forward input had to be manually adjusted for any prior year consolidated differences
to be properly reflected in the member company’s 2016 NOL calculation. To help automate this process,
these grids were created.

The grids are a summary of the application of the Net Operating Loss carryover on the consolidated return.
These summary grids provide a detailed comparison of each member’s separate company NOL carryover to
the consolidated NOL carryover attributed to it and show the adjustment, if any, that needs to be made to
member's company 2016 Pro Forma to reflect any 2015 consolidated NOL adjustments.

You can export the new grid to a Microsoft® Excel® spreadsheet from the 2015 consolidated tax return and
then import to the same grid in a member company’s 2016 tax return. Once this is done, you may elect to
have the program use these adjustments to calculate the member’s company current year NOL deduction.
Your original 2016 rolled forward input remains unchanged. Importing these spreadsheets to a 2016
consolidated member's return does not cause the automatic update to be performed. To select this option,
enter an X in the “Adjust this non-consolidated company’s NOL Pro Forma based on it prior year
consolidated membership” field on the Option to Adjust Member Companies' Pro Forma worksheet.

Tip: To easily check if Pro Forma adjustments are required in a consolidated member’s return,
select the Consolidated to Separate Company Difference column. If an amount other than 0 is
present, an adjustment is needed for that carryover year on the member’s return.

Note: The “Adjust this non-consolidated company’s NOL Pro Forma based on its prior year
consolidated membership” field on the Option to Adjust Member Companies' Pro Forma worksheet is
not applicable for 2015 tax return processing. It will be fully functional in 2016. It is mentioned here
to give you background about and notice of this new feature.

Electronic Filing
Form 114. If the same character is entered, regardless of how many times, for all of a Foreign Taxpayer
Identification Number, disqualifying diagnostic 56463 is issued to prevent the export of the return.
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California Combined
The program now recognizes "Other" allocation/apportionment elimination entries.

Kentucky Electronic Filing
Diagnostic 47652 will issue when there is an invalid address entered for PTE-WH.

Massachusetts
Credit Manager Schedule. New input was added to override the calculated prior tax period end date. Also,
the credit shared amount of the Economic Development Incentive Credit on Part 1, Column g, now includes
credit shared in all prior years if the certificate number is entered.

Nebraska
The insurance company check box on Form 1120N, Line 11, is now accessible and input was added to
Nebraska > General > Basic Data to indicate it's an insurance company return.

Nevada
The preliminary version of the Nevada Commerce Tax Return is available on this release. Input is on the
Nevada > General worksheet. This is a new return for tax year 2015 that is due on August 15, 2016. The
return is a paper only filed return. Electronic filing is not available for the state of Nevada. The final
version of the form has not been released by Nevada. Upon it's release, it will be included in our next
available release.

New Hampshire
BT- Summary, Page, 3, Print Signatory Name and Title, now prints both signatory name and title.

New York
A recalculation issue is fixed for “small business” filers on Form CT 3.3. - Modified Form CT 3.3 to default to
10% allotment for small businesses with current loss - Modified Forms CT 3.3 Schedule B to always print the
schedule even when zero.

New Combined Franchise Tax Return government forms are now available. Significant changes were made
to form CT-3A (Combine) and Form CT-3/AB (Member's Detail Report).

The NOL carryover report was updated to show the correct amount prior to PNOLC conversion.

Rhode Island Combined
RI-1120C Schedule F will pull the Federal taxable income amounts of the separate members' to the
consolidated return.

Wisconsin
Codes 28 (Total deductions - override) and 35 (Modified Federal Taxable Income Total - override) were
added to the Adjustments to Modified Federal Taxable Income section of the Wisconsin > Wisconsin
Combined Returns > Form 6 Eliminations/Adjustments worksheet. Code 1 ( Modified Federal Taxable Income
- override) was added to the Adjustments to Unitary Income section of the Wisconsin > Wisconsin Combined
Returns > Form 6 Eliminations/Adjustments worksheet.
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Combined apportionment eliminations entries on the Federal > Common State > State Intercompany
Elimination for Apportionment worksheet in the consolidating unit will appear on Form 6, Part III, Lines 1a -
1d, Form A-1, and the Wisconsin Combined Apportionment Schedule.

If the non-sharable net business loss carryforward from Form 6BL is used completely the amount in Column F
will show 0.

The 100,000 dollar threshold to produce Schedule RT for combined group members is calculated by
multiplying the amount of related entity expenses times the percentage for the combined group member on
Form 6, Part III, Line 1d.

The pre-2009 net business loss calculated on Form 6BL is pro - rated by the number of days in the tax period
up to 365 days. The ability to override the calculated dates for pre-2009 net business loss from previous
years was added on the Federal > Income/Deductions > NOL Carryforward/Carryback detail > State
Carryover Companion worksheet in the tax year beginning and ending dates fields.

Wisconsin Electronic Filing
Diagnostics 47552 and 47553 requiring the revenue account or parcel number and question C and D answers
for Schedule MA-M were removed. This information is no longer required if the only source of Manufacturing
credit is credit passed through from other entities.
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S Corporation (1120S) Product Updates
Return to Table of Contents.

Federal
Estimate Reminder Letter. The letter date will always fall on the first day of the month that the federal
estimate is due.

The IRS issued Revenue Procedure 2016-29. It included thirteen new automatic change codes to be used on
Form 3115. The program was updated to include the new change codes.

Delaware
Form DE 1100S, Schedule A-1, Percentage of stock owned field, now displays correct percentage when the
percentage is 1%.

Illinois
Schedule K-1-P(3), Pass-through Withholding Calculation for Nonresident Members, no longer limits credits
reported when Line 12, member's share of Illinois income subject to pass-through withholding, is zero or
less.

Nebraska
Schedule II, Column B, prints the EIN for shareholders with an entity type of E or C.

Nevada
The preliminary version of the Nevada Commerce Tax Return is available on this release. Input is on the
Nevada > General worksheet. This is a new return for tax year 2015 that is due on August 15, 2016. The
return is a paper only filed return. Electronic filing is not available for the state of Nevada. The final
version of the form has not been released by Nevada. Upon it's release, it will be included in our next
available release.

New Jersey
Changes were made to composite Form NJ-1080-C to ensure correct income reporting for nonparticipants on
Schedule B when there are eight or more nonparticipants.

North Carolina
The tax rate on 2016 estimated taxable income was changed to 5.75% from 5.499% (unchanged from 2015
tax rate).

Tennessee
The Direct Debit Report and the banking diagnostics no longer indicate an amount will be withdrawn when
direct deposit refund on the Federal > General > Basic Data > Direct Deposit/Electronic Funds Withdrawal >
Deposit Refunds/Direct Deposit field is incorrectly requested on a balance due return and confirm account
information on Federal > General > Basic Data > Direct Deposit/Electronic Funds Withdrawal is selected.
Tennessee does not accept direct deposit.
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Fiduciary (1041) Product Updates
Return to Table of Contents.

Federal
Final year returns utilizing the alternate expense allocation method accurately utilize the short term capital
gains expenses.

Grantor Letter

Other income items that do not have a description will default to "Other Income" as a
description.
The following items and passthrough items were added to the grantor letter.

1. Trust Section 453A interest
2. Trust Section 453(I) interest
3. Interest on deferral of gain from constructive ownership transactions
4. Passthrough entity information:

a. Investment income
b. Investment expenses
c. Self-charged passive interest expense
d. Nondeductible expenses
e. Other tax exempt income
f. Cancellation of debt - amount to 8582
g. Schedule E investment interest expense
h. Gross farming and fishing income
i. Section 1411 net investment income or adjustment
j. 453A interest
k. 453 interest

Schedule K-1

The capital gains to be distributed will match what is on the expense allocation worksheet
unless there is a limitation on the Form 1041, Schedule B. To present net capital gains and net
capital losses separate from each other in a final year return, select Beneficiaries > Distribution
Information > Distribution Options > Distribute net capital loss to beneficiaries.
When utilizing the option to distribute capital gains if distributions exceed ordinary income, the
Schedule K-1 will accurately reflect the distributions for the tax-exempt income.

Alabama
Form 41, Schedule E, Part II, Income from Partnerships, S Corporations, Estates and Trusts, will now
calculate the using all losses from a publicly traded partnership entered on Income/Deductions > Partnership
Passthrough (Schedule E).

Form Schedule G, Line 7, Other Income, is only calculated for resident beneficiaries.

Form Schedule K-1, Lines 10 and 11 statements, correctly allocate between other income and business
income.
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Connecticut
Form 1041 FA, Line 4, now includes the ESBT amount, when applicable.

Georgia
Georgia Extension Custom Filing Instructions. Special instructions only produce for mailing payment with
Form IT-560, as Georgia does not accept electronic filing or payment for Forms IT-303 and IT-560.

Illinois
Schedule D, Columns G and F, now reflect the input overrides when entered.

Iowa
Form IA 1041, Line 14, always includes the Federal amount of other deductions not subject to the 2% floor.

Michigan
When an option of "MO" for property sold outside the state is selected on Income/Deductions > Gains and
Losses > Business Property Casualty and Theft (detail) > State use - code 22 , the Michigan amount on Form
MI-4797 will be zero.

When an option of "M" for property sold inside the state is selected on Income/Deductions > Gains and Losses
> Business Property Casualty and Theft (detail) > State use - code 2, the disposition will not flow to Form MI-
4797.

Mississippi
Form 81-132, Line 10, Final year deductions for capital loss, shows for nonresident beneficiaries.

Nevada
The preliminary version of the Nevada Commerce Tax Return is available on this release. Input is on the
Nevada > General worksheet. This is a new return for tax year 2015 that is due on August 15, 2016. The
return for a paper only filed return. Electronic filing is not available for the state of Nevada. The final
version of the form has not been released by Nevada. Upon it's release, it will be included in our next
available release.

New Jersey
Total distribution on NJ K-1 now limits the distribution from a passthrough if an amount is entered for
Distribution (Accounting Income Only).

New Mexico
Extension letters and filing instructions now mention Form RPD-41096, Application for Extension to File and
Form FID-EXT, Fiduciary Extension Income Tax Payment Voucher, when applicable.

New York Electronic Filing
The amended return resulting in a refund and an estimated tax penalty reflects a refund less the estimated
tax penalty.
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North Dakota
Form 38, Page 3, Lines 2 and 3, and Schedule K-1, Lines 36 and 37, print amount of withholding allocated to
nonresident beneficiary(s) in a grantor trust when input on North Dakota > Other > Nonresident beneficiary
Withholding Information.

Form Schedule K-1, Part 5, Line 37, North Dakota income tax withheld, is not limited to "Individual"
beneficiaries entered on Beneficiaries > Beneficiary Information > General > State use.
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Estate & Gift (706/709) Product Updates
Return to Table of Contents.

Connecticut
The following preliminary Connecticut form is available for dates of death in 2016: Form CT-706 NT.
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Exempt Organization (990) Product Updates
Return to Table of Contents.

Federal

Letters and Filing Instructions.

The Accountant prepared paragraphs are no longer suppressed when the option to suppress the
State Annual report custom filing instructions special instructions is entered in General >
Letters and Filing Instructions > Standard and Special Paragraphs > Line 17.
The correct IRS mailing address prints on the Federal Exempt Organization Letters and Filing
Instructions for the Foreign and U.S. possession organizations when the input to do this is
entered under General > Basic Data > Line 20 - "Use foreign country IRS mailing address."

The Accountant prepared paragraphs are no longer duplicated in the State Custom Filing Instructions.

The paragraph stating the federal forms need to be attached now appears in the transmittal letter and filing
instructions for New York if the option to prevent federal attachments is not selected in New York > Annual
Report (Form CHAR500) > General > Form CHAR500 General Information > Federal attachment code.

The special paragraph "No fee is required" now produces for NY Form CHAR500 when the Form CHAR500,
Page 1, Section 3, boxes are marked correctly and the exemption requirements are met.

California
The extension letter and filing instructions for Form 199 shows an extended due date when Federal > Other >
Extensions > State Extension Information > Federal Form Type is 990-EZ or 990-PF.

Minnesota
The amount for All Other Expenses on the Annual Report, Section C, Line 24d, is now added to the Total
functional expenses on Line 25, Section C.
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